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ooh!Media Message Editor

The Message Editor is used to create messages for your sign.
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Text panel

The dockable window “Text” is used to edit properties of the selected text object of the message.
The parameters that can be changed are: “Font”, “Shadow”, and “Alignment” which are used to
make changes to the visual appearance of the text in the text object. You can add “Run-time objects”
(ex. time, or temperature).
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Font 1 is used for changing font-family, (for ex.
Times New Roman, Arial). Times New
Roman is the default selection
2 is used for font-size changing. The num-
ber of lines can range from 1 to 16. The
minimum size of the text object is 1/16,
the maximum size is 1
3 is used for text color changing
4 is used to change the color for the back-
ground region of the text object. It is trans-
parent by default
5 is used to set transparency for the text
6 is used for changing spacing characteristic
Shadow 7 is used for changing depth of the shadow
8 is used for changing the shadow’s direc-
tion
9 is used for choosing the color of the
shadow




10 is used for setting transparency for the
text’s shadow

1 full shadow

Alignment 12 aligns left edges of the text

13 centers horizontally in the region

14 aligns right edges

15 vertically aligns text to the top of the
region

16 vertically aligns text in the center of the
region

17 vertically aligns text to the bottom of the
region

18 sets the bold type

19 sets the italic type

20 assigns the Flash effect to the part of the
text string

Run-time 21 inserts the current time into the message
objects - -

22 inserts the current date into the message

23 inserts the current temperature into the
message

24 inserts a counter object

25 sends real-time data to the sign

26 is used to select a special symbol to insert,
for example 0, &

27 adds text

Note: An RSS Feed (Really Simple Syndication) is a web address that sends real-time data to
the sign.

See RSS Feed tutorial.



Background panel

The dockable window “Background” is used to manage the background layer of the message. The
window “Background” allows you:

1. To set the background as a color.

2. To set the background as an image.
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5 cycles the number of repetitions according to the

object’s duration in the Frame Sequence




Note: Itis possible to load a picture, animation, or movie to the background layer. Below is the
list of valid background objects:

* Static picture -static picture can be imported from files (.bmp, .jpg, .jpeg, .gif formats)
* Animated Sequence - animated picture can be imported (.gif format)

* Movie file - movie can be imported (.avi format)

Frame Sequence panel

The dockable window “Frame Sequence” displays the message based on the TimeLine. The
message content is divided into layers:

e Text, linked to Time;
+ Background;

* Text, linked to Background.
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Elements of the “Frame Sequence”:

TimeLine 1 represents the time visualization

Text object 2 linked to time

Text object 3 linked to the background

Background 4 it is a background object (ex. .jpg,
.Jbmp, .gif, .avi)

Total time 5 represents the total time of the mes-
sage




Current time 6 this is the lowest limit (by time) of
the selected background object

Text layer 7 contains text objects linked to time

Background layer 8 contains a background object

Text layer 9 contains text objects linked to the
background

Background Layer:
 Layer name — background with layer icon;
¢ Background object;

 Background object contains the name of the imported file [.bmp, .jpg, .avi]; flag “Color” in
case the background contains only color.

Text Layers:

 Text layer linked to time contains texts objects, linked to time;

» Text layer linked to the background contains texts objects, linked to the background.
Note: Each text object is represented as a region. Each region has characteristics:

« Color;

o Text;

* Duration (in seconds).

Elements of the Text linked to the background:

1. The duration (time) of the text can’t be longer than the duration of the background
object;

2. The text object can’t start earlier than the background object;

3. The text object can’t stop later than the background object.

Elements of the Text linked to time:
1. The duration of the text is an independent value;
2. The text object can start and stop at any time.




Effects panel

The dockable window “Effects” allows assigning different effects to different objects. The window
is divided in two parts:

» “Appearance Effect”
* “Hold Effect”
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Appearance Effect Properties:
» “Effect” #1 contains the effects that can be applied to the layers;

+ “Direction” #2 selects the direction for the selected appearance effect;

» “Speed” #3 allows setting the speed for the selected effect.

Hold Effect Properties:
o “Effect” #4 defines the type of the hold effect;
* “Hold Time” #5 defines how long the hold effect will be applied to the layer;
+ “Direction”#6 selects the direction for the selected hold effect;

« “Speed” #7 allows setting the speed for the selected effect.

“Play” #8 is used to preview the applied effect. The Emulation window displays the message in
WYSIWYG (What You See IS What You Get).



Media Library panel

The dockable window “Media Library” is used for managing the media library. The media library
contains media files such as pictures and animations. In this window you can:

1. Navigate through the media library.

2. Create a new folder. To create a folder click “Create a folder” button.

3. Delete a category. In order to delete the existing category it is necessary to select the
category to be deleted. The category will be deleted with all the embedded files.

4. Add a new file to the folder. A new file will be added to the currently selected cate-
gory.

5. Delete a file from the media library. Highlight the selected file and hit the “Delete” key
on you keyboard.
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2 adds a new category
3 deletes a category
4 adds a new file to the media library
5 shows files as pictures with names
6 gives the detailed view of the file
7 the viewing region




Media library divides all files by sign family first (ex. “StreetSmart”, “Excite”).

Within the sign family folder all files are divided by supported color palette. For example
“StreetSmart” signs can support one of two palettes: “Red”, “Amber”; “Excite” signs can support
only “RGB”.

Within the color palette folder all files are divided by size. Each size folder contains files grouped
by categories.For example, 200x170 is:

200 = The number of columns.
170 = The number of rows.
Select the size that is most similar to your sign.

Each category contains a number of media files. The size folder can contain non grouped files as
well.

Preview modes:
1. “Detailed”.This view gives the following properties in a list:

* File name;
* Description;
* Size (sign matrix size);

« Date modified;
2. “Thumbnails”. This view shows files as small pictures with names.

Emulation area

The main window of the Message Editor contains the Emulation Area.

The Emulation Area has two different modes:
1. Edit Mode is used to edit the message.
2. Run Mode is used to view the message in real-time.



Frame Filmstrip panel

The dockable window “Frame Filmstrip” is assigned to display the background layer as a sequence
of frames.The “Frame Filmstrip” window contains the following items:



Message frames
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Folder appearance
The sequence of background objects are displayed as a folder #2 with:
* “Name” #1;

+ “Plus” icon for expanding frames;

o “Minus”#4 icon for collapsing frames.

Scroll bar
If the total length of items is larger than the size of the window, scroll bar #3 appears.

Frame appearance
Each background object consists of frames. Each frame contains the following information:

« Frame #5. A frame image is a picture of the Emulation area and it represents the appearance
of the sign when the frame is being displayed on the sign;

* Frame number #6 is the frame count within the folder;

 Frame duration #7 (in seconds).



Step-by-Step Tutorials

Step-by-Step Tutorial - Messages

Messages contain one or more background that can be transmitted to a sign. Messages support text,
images (.gif, .jpg) and movies (.avi, .gif).

Creating a new text message

To create a new text message:

1. Open ooh!Media.

2. Click on the “File” menu item.

3. Select the “New” menu item.

4. The Emulation panel will appear.

5. Select “Insert text”, or left select in the Emulation region on an area that does not have
a text object.

6. Your new message will be displayed in the emulation area.

7. If you are satisfied with your message, click on the Save button.

Video - Creating a text message



Step-by-Step Tutorial - Text Properties

Properties for the text string in the message can be modified.

Opening the “Text” window

To open the “Text” window:

Open ooh!Media.

Click the View menu item.
Select the Text menu item.

The window “Text” will appear.

N

Note: The text layer can contain a number of text objects. The window “Text” is assigned to edit
only one (selected) text object.

Video - Editing text properties

Changing font colors

To change font colors:

1. Highlight the text.

2. Click the Color palette.

3. Choose the color you want to use.
4. Click the OK button.

Changing the font size

To change the font size:

1. Highlight the text.
2. Choose the size you want from the drop-down list.
3. The changes will be displayed in the Emulation window.

Changing the spacing
To change the spacing:
1. Highlight the text.

2. Click on the Spacing button.
3. Choose the spacing you want.



Changing shadow parameters

To change the direction of the shadow:

1. Highlight the text.
2. Move the mouse with the left button pressed on the direction circle.

To change the depth of the shadow:

1. Highlight the text.
2. Choose the depth you need in the drop-down list.

Note: The depth is how thick the shadow is.



Step-by-Step Tutorial - Media Library

The Media Library is a structured data storage location for image (.gif, .jpg) and movie (.avi, .gif)
files.

Creating a background from the Alphamation media library

To create a background:

Open ooh!Media.

Click the View menu item.

Select Media Library.

Select the file icon within the list of the message.
Use Drag-and-drop operation.

Drop the dragged file’s icon in:

ogakrwnE

* “Frame Filmstrip” window. The new object will be created between two background objects.

» “Frame Sequence” window. The new object will be created between two background
objects.

+ “Emulation area window”. The new object will be created at the end of the sequence of
background objects.

Video - Creating a background

Creating a new category

It is possible to add a new category to the currently selected folder:

Click the Create a new category button.

The popup window “New category” will appear.
Enter the name of the new category.

Click the OK button.

HowbdpE

Video - Creating and deleting of a new category

Deleting a category

It is possible to delete a category from the Media Library:

1. Select the category to be deleted using the combo box.
2. Press the Delete category button.


file://T|/Technical%20Documentation/MM/WIP/97118101AlphanetPro/ANPROHELP/Graphics/text.swf

3. The confirmation window for the “Delete” operation will appear.
4. Confirm the deletion operation.
5. The category will be deleted with all embedded files.

Adding a file to the Media Library

It is possible to add a file to the Media Library:

1. Click the Add new file button.
2. Standard “Open” dialog window will open.
3. New file will be added to the currently selected category.

Video - Adding a file to the Media Library



Step-by-Step Tutorial - Adding Effects

The ooh!Media application provides the ability to assign different effects to the background or to the text
object.

Adding effects to the text
To add effects to the text:

Open ooh!Media.

Click the “View” menu.

Select the Effects menu item.

Choose the necessary effects.

Press the Play button to preview the applied effects.
Click the Save button to save your changes.

ogakrwnE

Video - Adding effects


video/adding%20effects%20update.swf

Step-by-Step Tutorial - Adding RSS Feed

An RSS feed from the Internet can be added to the message.

Adding RSS Feed
To find an RSS Feed:

Open Internet Explorer.

Go to cnn.com.

Find RSS Feeds.

Highlight the RSS Feed you want.
Copy the RSS Feed.

Go back to the ooh!Media.

Set the properties in the RSS Field.

Nooakswbdh e

Video - Searching for an RSS Feed

To add RSS feed:

Open ooh!Media.

Click Insert menu item.

Select “RSS Feed”.

The popup window “RSS Field” will appear.

Paste the RSS Feed in the “RSS Field”.

Set characteristics of RSS Feed in the “RSS Field”.

Click the OK button.

The new text object with RSS is created in the centre of the Emulation area.

Video - Adding RSS feed

N~ WD



ooh!Media Message Scheduler

The Message Scheduler is used to create schedules for Signs. It allows creating various schedules,
assigning schedules to specific signs, reading schedules from signs and creating custom play lists.
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The Schedule document

The Schedule document is used to view the information about schedules in different modes, and also

allows editing them.
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Elements of the Schedule document:

1 Tab panel allows the user to switch between opened schedules
2 Start allows the user to set start date and time for the
Date/Time | viewable portion of the schedule
controls
3 Date Mode | is used to switch time interval for which schedule
switch con- | will be displayed
trols
4 Main Docu- | is used to display and edit schedules
ment Area
5 Schedule allow performing additional actions with the
document selected play list
popup menu
6 Play List shows the user what colors the different Play List
Recurrence | Recurrence types have
Type Leg-
end

Date Mode controls:

Date Mode controls are used to specify the time mode in which the content of a schedule will
be displayed.



1

NI |
|
[_ Today [—L?IJ r_lﬂ\‘l @ [ Cuskom _] [1 ] [Hu::urs "'"]

» Today” button #1 is used to display the schedule for today;
» “Day” button #2 is used to display the schedule for the day selected in the calendar.

* “Week” button #3 is used to display the schedule for the week starting from the day selected
in the calendar window, or in the “Date and Time” control on the left;
Start D ate Start Time
(2311.2006 see| [00:0000  eed

+ “Month” button #4 is used to display the schedule for the month starting from the day
selected in the calendar window;

+ “Custom” button #5 is used to display the schedule for the number of time periods as selected
in the Numeric control, starting from the day selected in the calendar window;

* Numeric control #6 allows the user to set the time interval for the schedule that will be
shown;

« The combo box #7 is used to define time increment for custom time intervals.

Simulator

The dockable window “Simulator” is used to view the content that will be played for the currently
active schedule.

Sirnulator




Components:

Sign simulator #1 is the region used to display content that will be shown on the sign.

Play List panel

The dockable window “Play List” is used to add a new Play List to the active schedule.
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Elements:

» Category combo box #1- contains custom categories (names of categories come from the
corresponding names in the Play List Management dockable window) for play lists and
allows the user to filter play lists shown in the list view;

« “Play List” data pop-up menu #2 contains list of data fields to display for a play list and
allows the user to set visibility of the field;

 The list of available Play lists #3 allows the user to select a play list to add to the schedule.

Schedule panel

The dockable window “Schedule” is used to define time and recurrence settings of Play Lists which
exist in the “Play List” dockable window or in the Schedule document window.

Recurrence Types:

The recurrence panel allows the user to choose the recurrence type for the play list. It defines
time period(s) within which the play list will be displayed on the sign. There are four play list
recurrence types:



Once

“Once” recurrence means that the play list will be shown one time only.
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Apply changes

» Recurrence Panel #2 (the “Once” radio button #1 should be selected);

 Play List Start Panel #3 allows the user to select the play list start time and date;
 Play List End Panel #4 allows the user to select the play list end time and date;
 Control Buttons Panel #5 contains the “Add Play List”, or “Apply changes” button.

Note: If the play list is selected in the “Schedule” document window then the window has

the “Apply Changes” button; if in the “Play List” dockable window - the “Add Play
List” button.

Daily

“Daily” recurrence means that the play list will be shown periodically with one or more day
period.
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Recurrence Panel #2 (the “Daily” radio button #1should be selected);

Play List Time Panel #3 allows entering play list start time and play list end time;

Range of Recurrence Panel #4 allows setting the play list recurrence characteristics;

Control Buttons Panel #5 allows applying changes or adding play list to the
schedule;

The “Add play list” button #6 adds the schedule to the schedule document window.

Weekly

“Weekly” recurrence means that the play list will be shown each week during the time
interval selected.
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» Recurrence Panel #2 (the “Weekly radio button #1 should be selected);

will be shown;

Monthly

Play List Time Panel #3 allows entering play list start time and play list end time;
Range of Recurrence Panel #4 allows setting the play list recurrence characteristics;

Recurrence Pattern Panel #5 allows selecting the days of the week when the play list

Control Buttons Panel #6 allows applying changes or adding the play list to the
schedule.

“Monthly” recurrence (the play list will be shown each month for the time intervals

selected).
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* Recurrence Panel #2 (the “Monthly” radio button #1 should be selected);

Play List Time Panel #3 allows entering play list start time and end time;
Range of Recurrence Panel #4 allows setting the play list recurrence characteristics;

Recurrence Pattern Panel #5 allows choosing the days of the month from the

calendar #6, or weeks of the month and days of the weeks for recurrence;

Sign panel

Calendar #6 allows choosing any day within the month for the recurrence pattern;

The “Apply changes” button #7 allows applying changes to the schedule.

The dockable window “Sign” allows the user to upload schedules to the chosen sign(s), and
download the schedules from the selected sign(s) as new schedule documents.The user can also
update existing schedules for the selected sign(s).
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Properties of the Sign panel:

“Choose Signs” list/tree view #9 allows the user to select sign(s).

Filtering signs #10 - the user can filter signs that are displayed in the dockable window
“Sign”. In order to filter signs that have a certain property value the user should select the
sign(s) with this property value and click on the header of the column that corresponds to this

property.

“Get Schedule” button #1 allows the user to download schedule files for all selected sign(s)
or schedule(s) will be downloaded to the computer and schedule document(s) will be
opened.

“Send Schedule” button #2 allows the user to choose a schedule file which should be
uploaded to the selected sign(s).

“Update Schedule” button #3 allows the user to update selected sign(s) using the currently
assigned schedule.

Choose Signs list view popup menu #4 allows the user to select the columns which will be
displayed in the list view.

Signs State Legend displays current sign state. There are four possible states:

» Grey icon #5- Unknown. This is a state when no connection with the sing has been
made.

» Red icon #6- Communication Error. This is a state when a communications error has
occurred while the user was trying to upload, download, or update the signs’
schedule.

* Blue #7- Operation in progress. This is a state when upload, download, or update
operation has started communications with the sign but not finished yet.

» Green #8- Operation is successful. This is a state showing that upload, download, or
update operation was successfully completed.

The “Edit” #11 button allows the user to edit signs. When the user clicks the “Edit” button,
the Location Managers appears;

The “Delete” #12 button deletes signs from the list;

The “Add” #13 button allows the user to add a sign to the list. When the user clicks the “Edit”
button, the Location Manager appears;

The “Commands”#14 button allows the user to set commands to the selected sign.

Location Manager

The dockable window “Location Manager” is assigned to “Edit/View” characteristics for the
existing sign. It consists of two parts:

Sign Configuration

Sign Communication
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Sign configuration:
Sign “Name” #1 represents the name of the sign;

Sign “Family” #2 represents the family of the sign. (ex. Excite, StreetSmart, RoadStar,
Infinity);

Matrix “Height” #3 represents the height of the sign in pixels;
Matrix “Width” #4 represents the width of the sign in pixels;

“Number of faces” #5 represents the information about the number of faces that are
supported by the sign and the behavior of the faces (ex. Master, Master-Master,
Master-Slave);

“Color” #6 represents the information about the color model that is supported by the chosen
sign family;

“Communication Type” #7 represents the type of communication by which sign connects
with the PC (for ex. Ethernet, Local host, Serial, Modem, RF Wireless);

Sign Communication:

The Sign Communication part depends on the chosen Communication Type.



o “IP addresss” #8 allows the user to set the IP address, or Host name;
+ “Service Port” #9 allows the user to set the port.

+ “Auto Detect” #10 helps to get the parameters of the sign.

Sign Commands

The dockable window “Commands” is assigned to set commands for signs or sign groups.
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Available Commands:

* The “Set time and date” command #1 is used to set time and date for the sign. It is possible
to do the following:

* Synchronize time with the time on the personal computer #4;

+ Set a definite time and date #5.
e The “Clear Memory” #2 is used to clear the physical memory of the sign.
* The “Change Password” button #3 is used to change the password.

* The commands are executed only after the “Send” button #6 is clicked.

Play List Management panel

The dockable window “Play List Management” allows the user to create, edit and delete Play Lists.
A Play List is a group of messages, which are associated to a single group of messages.
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Components of the Play List Management panel:

1 “Play lists” | allows the user to view all existing play lists in the Library
tree view
control

2 “Messagein | contains information about messages, which are in the currently
the Play selected Play List; allows setting additional properties for the
List” list Message recurrence behavior and priority in the Play list
view control

3 Add Play allows user to create a new play list and add it to the library
List Button

4 Delete Play | allows the user to delete the selected play list from the library
List Button

5 Edit Play allows the user to edit the currently selected play list
List Button

6 Import Play | allows the user to add an externally existing play list from the
List Button | selected location to the library

7 Export Play | allows the user to save the existing play list to the selected loca-
List Button | tion

8 Add Cate- allows the user to add a new category to the play list library
gory Button

9 Delete Cate- | allows the user to delete the currently selected play list category
gory Button | or subcategory

10 Edit Cate- allows the user to edit the name for the currently selected play
gory Button | list category or subcategory




Step-by-Step Tutorials

Step-by-Step Tutorial - Create a Play List

Creating a Play List

To create a Play List:
Open the Message Scheduler.
Open the dockable window “Play List Management”.

Press the “Add” button. (=]

The “Play List Creation” pop up window will appear.
Press the “Browse” button.

Select the directory where your messages are located.

oukrw ME

Note: the user can not select directories outside the installation folder using this button.

7. Choose a message from the “Available Messages” list view.

8. Press the “Add Message” button. (=)

9. Your message will be added to the currently active Play List.
10. Press the “Save as” button.

11. “Save as” dialog will be shown.

12. Set the location and file name for the Play List.

13. Press the “Save” button.

Note: the message doesn’t disappear from the Message Library after adding it to the Play List.

Video - create a play list

Adding Message from Disk

The user can add a message to the Play List from a specific location:
1. Open the “Play List Management” dockable window.

Press the “Add” button, [
The “Play List Creation” pop up window will appear.

Press the “Add Message from disk” button. (@]
The “Open file” dialog will appear.
Add the message to the Play List from the specific location on disk.

gk wh

Note: the added message is copied to the currently opened directory.



Step-by-Step Tutorial - Managing a Play List

Importing a Play List

To add existing play lists to the play list library:

Open the Message Scheduler.
Open the “Play List Management” dockable window.

Press the “Import Play List” button. @

The “Open file” dialog will appear.

Choose a Play List to import.

Press the “Open” button.

The Play List from the selected location will be copied into the play list library loca-

Video - Import a Play List

Exporting a Play List

To export existing play lists to the selected location:

1
2
3.
4
5

Open the “Play List Management” dockable window.

Press the “Export Play List” button. [+

The “Save file” dialog will appear.
Press the “OK” button.

. The Play List from the library will be copied to the selected location.

Video - Export a Play List

Adding a Category

A category list contains custom categories and allows the user to filter Play Lists shown in the list
view.

To add a category:

ocogagkrw N F

Open the dockable window “Play List Management”.

Press the “Add Category” button. =%

The pop up window will appear.

Enter the name for the new category.

Click the “OK” button

The new category will be added to the Play List Library.

Note: the subcategory will be added if the category is selected.

Video - Adding a Category



Step-by-Step Tutorial - Schedule Once reoccurrence Play List

Schedule Once reoccurrence Play List
“Once” reoccurrence type indicates that a Play List will be shown one time only.

To schedule a once reoccurrence Play List:

Open the Message Scheduler.

Choose a play list in the “Play List” dockable window.

Open the “Schedule” dockable window.

Select the “Once” recurrence radio button.

Set the Play List start date and time.

Set the Play List end date and time.

Press the “Add Play List” button.

The added play list will be shown in the Schedule document.

N~ WD

Video - Schedule Once reoccurrence Play List



Step-by-Step Tutorial - Set a reoccurring schedule for Play Lists

Set areoccurring schedule for Play Lists
The user can set the following types of recurrence for the play list:

+ Daily type indicates that the play list will be shown periodically each day for the range of
days specified.

» Weekly type indicates that the play list will be shown periodically each week for the time
period specified.

* Monthly type indicates that the play list will be shown periodically each month for the time
period specified.

To set a reoccurring schedule for the play list:

Choose a play list in the “Play List” dockable window.

Open the “Schedule” dockable window.

Select the “Daily” button.

Set the start and end time for the play list.

Set the range of recurrence you need.

For “Weekly” and “Monthly” set the “Recurrence pattern”.
Press the “Add play list” button.

The play list added will be shown in the Schedule document.

N~ LN

Video - create a reoccurring play list



	ooh!Media Message Editor
	Text panel
	Background panel
	Frame Sequence panel
	Elements of the “Frame Sequence”:
	Background Layer:
	Text Layers:

	Effects panel
	Appearance Effect Properties:
	Hold Effect Properties:

	Media Library panel
	Emulation area
	Frame Filmstrip panel
	Folder appearance
	Scroll bar
	Frame appearance

	Step-by-Step Tutorials
	Step-by-Step Tutorial - Messages
	Creating a new text message

	Step-by-Step Tutorial - Text Properties
	Changing font colors
	Changing the font size
	Changing the spacing
	Changing shadow parameters

	Step-by-Step Tutorial - Media Library
	Creating a background from the Alphamation media library
	Creating a new category
	Deleting a category
	Adding a file to the Media Library

	Step-by-Step Tutorial - Adding Effects
	Adding effects to the text

	Step-by-Step Tutorial - Adding RSS Feed
	Adding RSS Feed


	ooh!Media Message Scheduler
	The Schedule document
	Elements of the Schedule document:
	Date Mode controls:

	Simulator
	Components:

	Play List panel
	Elements:

	Schedule panel
	Recurrence Types:

	Sign panel
	Properties of the Sign panel:
	Location Manager
	Sign Commands

	Play List Management panel
	Components of the Play List Management panel:

	Step-by-Step Tutorials
	Step-by-Step Tutorial - Create a Play List
	Creating a Play List
	Adding Message from Disk

	Step-by-Step Tutorial - Managing a Play List
	Importing a Play List
	Exporting a Play List
	Adding a Category

	Step-by-Step Tutorial - Schedule Once reoccurrence Play List
	Schedule Once reoccurrence Play List

	Step-by-Step Tutorial - Set a reoccurring schedule for Play Lists
	Set a reoccurring schedule for Play Lists



